
Installing the 
ICS-1000 Ion Chromatography System

© 2003 Dionex Corporation

Document No. 031915
Revision 01
March 2003



©2003 by Dionex Corporation
All rights reserved worldwide.
Printed in the United States of America.

This publication is protected by federal copyright law. No part of this publication 
may be copied or distributed, transmitted, transcribed, stored in a retrieval system, or 
transmitted into any human or computer language, in any form or by any means, 
electronic, mechanical, magnetic, manual, or otherwise, or disclosed to third parties 
without the express written permission of Dionex Corporation, 1228 Titan Way, 
Sunnyvale, California 94088-3603 U.S.A.

DISCLAIMER OF WARRANTY AND LIMITED WARRANTY
THIS PUBLICATION IS PROVIDED “AS IS” WITHOUT WARRANTY OF 
ANY KIND. DIONEX CORPORATION DOES NOT WARRANT, 
GUARANTEE, OR MAKE ANY EXPRESS OR IMPLIED 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE 
USE, OF THIS PUBLICATION IN TERMS OF CORRECTNESS, ACCURACY, 
RELIABILITY, CURRENTNESS, OR OTHERWISE. FURTHER, DIONEX 
CORPORATION RESERVES THE RIGHT TO REVISE THIS PUBLICATION 
AND TO MAKE CHANGES FROM TIME TO TIME IN THE CONTENT 
HEREINOF WITHOUT OBLIGATION OF DIONEX CORPORATION TO 
NOTIFY ANY PERSON OR ORGANIZATION OF SUCH REVISION OR 
CHANGES.

TRADEMARKS
MMS™ MicroMembrane™ Suppressor is a trademark of Dionex Corporation.

AES® Atlas Electrolytic Suppressor, Chromeleon®, OnGuard®, and SRS® Self-
Regenerating Suppressor are registered trademarks of Dionex Corporation.

Teflon® is a registered trademark of E.I. duPont de Nemours & Co.

Windows® is a registered trademark of Microsoft Corporation.

PRINTING HISTORY
Revision 01, March 2003



Contents

Doc. 031915-01 3/03 i

1 Facility Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

2 Unpacking the ICS-1000 System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

2.1 Unpacking the Computer (North America only). . . . . . . . . . . . . 4

2.2 Unpacking the Computer (outside North America)  . . . . . . . . . . 4

3 Installing Chromeleon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

4 Installing the Chromeleon Software License  . . . . . . . . . . . . . . . . . . . . . 6

5 Connecting the ICS-1000 to the Chromeleon PC  . . . . . . . . . . . . . . . . . . 9

5.1 Connecting the ICS-1000 to the PC  . . . . . . . . . . . . . . . . . . . . . . 9

5.2 Connecting Additional USB Devices . . . . . . . . . . . . . . . . . . . . 10

6 Connecting the Power Cord . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

7 Turning On the ICS-1000 Power . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

8 Setting Up Chromeleon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

8.1 Assigning the ICS-1000 to a Timebase. . . . . . . . . . . . . . . . . . . 13

8.2 Assigning DX-LAN Devices to the Timebase (Optional)  . . . . 16

9 Installing and Plumbing the Columns and Suppressor  . . . . . . . . . . . . . 19

9.1 Column Heater Setup (Optional). . . . . . . . . . . . . . . . . . . . . . . . 19

9.2 Installing the Columns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

9.3 Installing the Suppressor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

10 Connecting the Waste Lines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

10.1 Installing the Gas Separator Waste Tube  . . . . . . . . . . . . . . . . . 23

11 Setting Up the Eluent Reservoir  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

12  Setting Up a Chromeleon Application . . . . . . . . . . . . . . . . . . . . . . . . . 26

12.1 Verifying Chromeleon Communication . . . . . . . . . . . . . . . . . . 35



ICS-1000 Ion Chromatography System

ii Doc. 031915-01 3/03

13 Setting the Eluent Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36

14 Priming the Pump . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37

14.1 Priming the Eluent Lines with a Syringe . . . . . . . . . . . . . . . . . .37

14.2 Priming with the Prime Button. . . . . . . . . . . . . . . . . . . . . . . . . .39

15 Equilibrating the System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40

16 Verifying Operational Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40

17 Connecting an AS50 Autosampler (Optional)  . . . . . . . . . . . . . . . . . . . .41

17.1 AS50 Configuration Requirements  . . . . . . . . . . . . . . . . . . . . . .41

17.2 AS50 Connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .42

17.3 Enable AS50 Control of the Injection Valve . . . . . . . . . . . . . . .44

18 Connecting an AS40 Automated Sampler (Optional)  . . . . . . . . . . . . . .45

19 Analog Output Connection (Optional) . . . . . . . . . . . . . . . . . . . . . . . . . .47

20 Pressurizing the Eluent Reservoir (Optional) . . . . . . . . . . . . . . . . . . . . .47

20.1 Connecting the Gas Source (Optional). . . . . . . . . . . . . . . . . . . .48

20.2 Pressurizing the Eluent Reservoir (Optional). . . . . . . . . . . . . . .49

21 Pump Continuous Seal Wash Connections (Optional) . . . . . . . . . . . . . .50

22 Manually Connecting to a Control Panel . . . . . . . . . . . . . . . . . . . . . . . .52

23 Installation Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .54



Doc. 031915-01 3/03 1

Installation

This document provides instructions for the initial installation of the ICS-1000 Ion 
Chromatography System. 

NOTE The order of the steps is important. It is especially
important to install Chromeleon® before connecting the
USB cable and turning on the ICS-1000 power.

1 Facility Requirements

• Make sure the ICS-1000 installation site meets the following environmental 
specifications:

Operating Temperature: 4 °C to 40 °C (40 °F to 104 °F)

Humidity: 5% to 95% relative humidity, noncondensing

• Provide a sturdy workbench for the ICS-1000 of a height that ensures 
convenient access to the interior.

• Allow at least 15 cm (6 in) behind the ICS-1000 for power connections and 
ventilation. For optimal performance, install the ICS-1000 in a draft-free 
location, out of the path of air conditioning and heating vents.

• (Optional) Provide a clean gas source regulated to between 0.55 and 
0.83 MPa (80 and 120 psi) for pressurization of the eluent reservoir.

• Use ASTM filtered, Type I (18-megohm) deionized water when preparing 
eluent and regenerant.
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2 Unpacking the ICS-1000 System

1. After removing the ICS-1000 from the shipping box and removing the top 
layer of foam, remove the next layer of foam (see Figure 1).

Figure 1. ICS-1000 After Removing Shipping Box and First Layer of Foam

2. Set the eluent bottle on top of the ICS-1000 (see Figure 2).

Figure 2. ICS-1000 with Eluent Bottle

Remove this foam

Eluent 
Bottle
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3. Remove the next layer of foam and remove the Ship Kit box (see Figure 3).

Figure 3. ICS-1000 with Ship Kit

4. The bottom foam layer has two cutouts on either side of the ICS-1000 
module; use these as hand holds when lifting the module (see Figure 3). 

5. Lift the ICS-1000 out of the bottom layer of foam and set it on a workbench. 
Inspect the ICS-1000 for any shipping damage.

Two or more persons should lift the ICS-1000, which weighs 30 kg
(66 lb). Lift the ICS-1000 only from each side of the cabinet bottom.
Lifting from the front door will damage the door hinges.

Au moins deux personnes peuvent soulever le ICS-1000:  il pèse 30 kg
(66  lb). Ne soulevez le ICS-1000 que par chaque côté du fond de
l'armoire. Son soulèvement par la porte du panneau avant
endommagera les charnières de la porte.

Der ICS-1000 wiegt über 20 kg. Daher sollte das Gerät nur von zwei
oder mehr Personen angehoben werden. Greifen Sie dazu an beiden
Seiten unter das Gerät. Heben Sie den Autosampler nicht an der
Vordertür an, da dadurch die Türangeln beschädigt werden könnten.
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2.1 Unpacking the Computer (North America only)

NOTE These instructions assume that Chromeleon®
software and the software license were installed on
the computer before shipping. 

1. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

2. Remove the monitor from its box and place it on the workbench.

3. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

4. Go on to Section 4, “Installing the Chromeleon Software License.”.

2.2 Unpacking the Computer (outside North America)

1. Refer to Installing the Chromeleon IC System (Document No. 
031883) to verify that the computer being used meets Chromeleon 
specifications. The manual is on the Dionex Reference Library CD-
ROM (P/N 053891).

2. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

3. Remove the monitor from its box and place it on the workbench.

4. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

5. If Chromeleon is not installed on the computer, go on to Section 3, 
“Installing Chromeleon.”

6. If Chromeleon is already installed on the computer, go on to 
Section 4, “Installing the Chromeleon Software License.”
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3 Installing Chromeleon

NOTES
• Windows® 2000 or Windows XP is required for controlling the ICS-1000 

with Chromeleon. Chromeleon version 6.5 SP2 or later is required.

• To install Chromeleon, you must log onto Windows 2000 or XP with 
administrator privileges. Administrator privileges are not required to 
run Chromeleon.

1. Turn on the computer power.

2. Follow the Windows setup steps as they appear on the screen.

3. Verify that the monitor display is set to a minimum of 1024 x 768 with 16 bit 
color.

4. Insert the Chromeleon CD-ROM into the CD-ROM drive.

5. The Chromeleon Setup menu appears.

6. If the Setup menu does not appear automatically, go to the Autorun folder on 
the Chromeleon CD-ROM and double-click autorun.exe.

7. Select Launch Chromeleon Setup.

8. Setup now guides you through the installation procedure; follow the on-
screen instructions as they appear. 

9. When prompted, select whether to add the Chromeleon Server Monitor to the 
Startup group. If you select yes, the Server Monitor starts automatically when 
the computer is started, and the program icon appears in the taskbar.

10. When complete, go on to Section 4, “Installing the Chromeleon Software 
License.” 
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4 Installing the Chromeleon Software License

For the Chromeleon computer to control the ICS-1000, a valid software license 
must be installed. To install the license, you first install a dongle on the computer 
and then enter a license “Key Code” in Chromeleon. (A dongle is an adapter that 
is connected to the parallel PC interface or USB port. The dongle stores the serial 
number of a Chromeleon computer.)

NOTE If the software license is managed via a License
Server, a dongle is not required. 

1. Plug the dongle into the appropriate port on the computer (either the parallel 
or USB port, depending on the type of dongle). Tighten the connector screws 
on a parallel port dongle.

2. If it is not already running, start the Chromeleon Server Monitor (select 
Start>Programs>Chromeleon>Server Monitor). The Server Monitor 
window opens. 

IMPORTANT
Installing DX-LAN Devices
If you will also be installing a module that requires a DX-LAN interface 
connection, verify that the following steps are completed before continuing:

1. If it is not already installed, install the DX-LAN card in the module. Refer 
to the operator’s manual for the module for installation instructions.

2. Install the DX-LAN card in the computer.

3. Connect the module to the DX-LAN.

4. Install the DX-LAN card driver.

Instructions for Steps 2 through 4 are in Installing the Chromeleon IC System 
(Document No. 031883).
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3. Check the server status:

• If “Chromeleon Server is running idle” is displayed, the license Key Code 
was entered before shipping the computer, and you can omit the 
remaining steps in this section. Click Close and go on to Section 5.

• If “Chromeleon Server is running idle (Evaluation Mode)” is displayed 
(see Figure 4), the license Key Code has not yet been entered. If this is the 
case, go on to Step 4.

Figure 4. Server Evaluation Mode

4. Open Chromeleon (select Start>Programs>Chromeleon>Chromeleon).
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5. Select File>Preferences to open the Preferences dialog box (see Figure 5). 
Select the License tab and click Dongle. Enter the Key Code exactly as it 
appears on the Chromeleon Software License key code sheet. Click OK.

Figure 5. Preferences: License Page

6. Check the Server Monitor status. It should now display “Chromeleon Server 
is running idle.” (see Figure 6).

Figure 6. Server Running

7. Click Close to close the Server Monitor window.

8. Go on to Section 5.
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5 Connecting the ICS-1000 to the Chromeleon PC

The ICS-1000 rear panel provides a USB receptacle for connecting the ICS-1000 
to a USB port on the Chromeleon PC. The rear panel also provides two USB ports 
for connecting other Dionex USB-compliant modules to the system.

5.1 Connecting the ICS-1000 to the PC

1. Locate the USB cable (P/N 960779) in the ICS-1000 Ship Kit 
(P/N 057905).

2. Plug the cable’s “A” connector into a USB port on the Chromeleon 
PC and plug the cable’s “B” connector into the USB receptacle 
(labeled FROM PC) on the ICS-1000 rear panel (see Figure 7).

Do not turn on the power to the ICS-1000 or other USB module(s) until
after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed.
If not, Windows will be unable to identify the new USB device when
the power is turned on. See Section 3 to install Chromeleon. 

Figure 7. Example Connections: One ICS-1000 Connected to the Computer

ICS-1000

USB Cable A

B

Plug the “B”
into the FROM PC 

receptacle on the ICS-1000.

USB cable’s 
connector 

Plug the “A”
into USB 

port on the Chromeleon PC.

USB cable’s 
connector the 

Chromeleon PC

FROM PC USB receptacle 
on the ICS-1000 rear panel
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5.2 Connecting Additional USB Devices

The ICS-1000 provides two USB ports for connecting additional Dionex 
USB-compliant modules to the system.

To connect an additional USB module, plug the “A” connector on a USB 
cable into an “A” port (labeled TO MODULE) on the ICS-1000 rear panel 
and plug the cable’s “B” connector into the USB receptacle on the USB 
module (see Figure 8).

NOTE If the number of USB devices in the system exceeds the
number of available USB ports, connect the devices to
the system with a USB-compliant, full-speed external
hub. One or more hubs is also required if the ICS-1000
or other USB device is more than 5 meters (16 ft) from
the PC. Refer to the manual provided by the hub vendor
for complete installation instructions. 

Figure 8. Example Connections: Two Dionex USB Modules Connected to the ICS-1000

The USB standard limits the USB cable length to 5 meters (16 ft). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters
(32 yds) from the PC.
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6 Connecting the Power Cord

Connect the power cord (IEC 320 C13) (ordered separately) from the main power 
receptacle on the rear panel to a grounded power source. The ICS-1000 power 
supply is auto-sensing, so no adjustment is required to select the line voltage.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-1000 or connect it to AC power
mains without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-1000 and is easily
accessible. 

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-1000.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.
Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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7 Turning On the ICS-1000 Power

1. If it is not already on, turn 
on the computer power and 
log onto Windows 2000 or 
Windows XP as an 
administrator.

2. Press the power switch on 
the ICS-1000 rear panel (see 
Figure 9) to turn on the 
power. 

Figure 9. ICS-1000 Rear Panel

3. Windows automatically detects the new USB device. A message flashes on 
the screen to inform you that new hardware was found. 

4. Go on to Section 8.

Before turning on the ICS-1000 power, verify that Chromeleon
software is installed. See Section 3 for installation instructions. If
Chromeleon is not installed first, Windows will be unable to identify
the new USB device.

Power
Switch
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8 Setting Up Chromeleon

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon user’s guide or online Help.

8.1 Assigning the ICS-1000 to a Timebase

1. If the Chromeleon Server is not running (the icon on the taskbar is 

crossed out in red ), start the Server by right-clicking the icon 
and selecting Start Server. When the server starts, the icon changes 

to gray . 

2. Open the Server Configuration program (select 
Start>Programs>Chromeleon>Server Configuration).

3. The Unassigned USB Devices dialog box appears (see Figure 10).

Figure 10. ICS-1000 Unassigned to Timebase
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4. Click the New button.

5. The Timebase box displays a default name (the Server Configuration 
name). You can use the provided name or type a new one (for 
example, ICS-1000). 

6. Press the Enter key.

7. In the Unassigned USB Devices box, select the ICS-1000 and then 
click the Assign button. The ICS-1000 is now assigned to the 
timebase (see Figure 11). If you are installing more than one ICS-
1000, you can verify the serial numbers for each by checking the label 
on the component panel.

8. Repeat Step 7 if you are adding additional USB devices to this 
timebase.

Figure 11. ICS-1000 Assigned to a Timebase

9. Click OK to close the dialog box. The Server Configuration program 
window appears.
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10. Click the + icon next to the server name to expand the folder. The 
timebase you created is displayed (see Figure 12).

Figure 12. Server Configuration with ICS-1000 Timebase

11. To verify that the ICS-1000 is correctly connected to the timebase, 
double-click its name under the timebase. Click Yes if the following 
message appears: “Communication to the device will be stopped…Do 
you want to continue?”
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12. The ICS-1000 System dialog box opens (see Figure 13). The General 
page shows the Device Name (Pump_ECD), the Mode (Live), and 
the Module Serial No. 

Figure 13. ICS-1000 System Properties

13. Close the dialog box and then save the configuration (select 
File>Save Installation).

14. If you are going to add one or more DX-LAN devices to the timebase, 
go on to Section 8.2. Otherwise, exit the Server Configuration 
program and then go on to Section 9.

8.2 Assigning DX-LAN Devices to the Timebase (Optional)

Follow the instructions in this section if you are adding one or more 
devices to the timebase that are connected to the PC through a DX-LAN 
interface (not through USB connections).

1. Follow the instructions in Installing the Chromeleon IC System 
(Document No. 031883) to add the DX-LAN card to the server 
configuration as a sharable device.
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2. Select the timebase that was created for the ICS-1000 (see Figure 14); 

then, click the Add device icon  on the toolbar (or select 
Edit>Add Device).

Figure 14. Example: ICS-1000 Timebase

The Add device to timebase dialog box appears.

3. If it is not already selected, select Dionex under Manufacturers and 
then select the device from the Devices list. 

Figure 15. Add Device to Timebase Dialog Box
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4. Click OK. A configuration properties dialog box for the device 
appears. Figure 16 shows an example of the properties for an AS50 
Autosampler.

Figure 16. AS50 Configuration Properties

5. On the General tab page, clear the Demo Mode check box if it is 
currently selected, and then select the DX-LAN Device ID number. 
Note: Devices display their DX-LAN ID numbers when their power 
is turned on.

6. Click OK to close the dialog box. 

7. Save the configuration (select File>Save Installation). 

8. Exit the Server Configuration program.

9. Go on to Section 9
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9 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. Before
beginning the installation, refer to the column and
suppressor manuals for detailed start-up and
installation instructions. The manuals are provided on
the Dionex Reference Library CD-ROM (P/N 053891),
which is located in the ICS-1000 Ship Kit (P/N 057905).

Before beginning:

• Remove the guard column, separator column, and suppressor from their 
boxes. 

• Remove the fitting plugs from the ends of each column and from all ports on 
the suppressor. 

• Discard any tubing temporarily connecting the suppressor ports.

9.1 Column Heater Setup (Optional)

Follow the steps below if the optional column heater is installed.

1. Cut off the two 
shipping ties from 
the column heater 
and remove them 
(see Figure 17).

2. Loosen the two 
thumbscrews on 
the heater cover 
(they remain 
attached to the 
cover).

3. Pull the heater 
cover straight out 
to remove it.

Figure 17. ICS-1000 Column Heater Setup

Thumbscrew (2)

Shipping Tie (2)
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4. Unscrew the six 
thumbscrews on the 
top metal plate (see 
Figure 18) and 
remove the plate.

5. Go on to 
Section 9.2.

Figure 18. ICS-1000 Column Heater Cover Removed

9.2 Installing the Columns

1. Remove the union connecting GUARD IN and GUARD OUT.

2. Connect GUARD IN to the guard column inlet. Check the arrow on the 
column label; it should point down (flow away from the injection 
valve).

3. Connect GUARD OUT to the guard column outlet.

4. Push the guard column onto the back column clip.

5. Remove the union connecting COL IN and COL OUT and 

6. Connect COL IN to the separator column inlet. Connect COL OUT to 
the separator column outlet. Check the arrow on the column label. It 
should point up (flow toward the cell).

7. Push the separator column onto the front column clips.

8. Replace the top metal plate on the column heater (if installed).

Thumbscrew (6) 
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9.3 Installing the Suppressor

1. Locate the suppressor 
mounting tabs on the 
component panel (see 
Figure 19). Reach into 
the opening between the 
tabs and pull the yellow 
connector and attached 
cable slightly out of the 
opening.

2. Connect this cable to the 
cable from the 
suppressor (align the 
pins on the two 
connectors and push 
them together).

Figure 19. Suppressor Mounting Tabs 
and Guidelines

3. Orient the suppressor with the REGEN OUT fitting on top and the 
cable to the right. 

4. Feed the cable into the opening in the component panel.

5. Align the top of the suppressor with the guideline printed on the 
component panel (see Figure 19) and align the slots on the rear of the 
suppressor with the tabs on the panel.

1 Suppressor

2 Suppressor Cable 

    Mounting Tabs
 

1

1
2

3
3 Guideline for AES 

        

4

4 Guideline for SRS

   Connector 

     

1
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6. Press the suppressor onto the tabs 
and then slide it down to lock it in 
place. Pull slightly on the center of 
the suppressor to verify that it is 
securely fastened. Figure 20 shows 
an SRS suppressor installed on the 
component panel.

7. Remove the union connecting 
ELUENT IN and ELUENT OUT and 
connect these lines to the 
corresponding ports on the 
suppressor.

Figure 20. Suppressor Installed 
(SRS Shown)

8. Remove the fitting plug from REGEN IN and connect it to the REGEN 
IN port on the suppressor. Connect the TO SRS/AES REGEN OUT line 
to the REGEN OUT port on the suppressor.

9. Replace the cover on the column heater (if installed), making sure the 
GUARD IN line is aligned with the slot on the side of the heater cover. 

10. Go on to Section 10.
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10 Connecting the Waste Lines

The ICS-1000 has the following waste lines:

• PUMP WASTE carries prime waste from the pump. 

• TO WASTE OUT carries sample overflow from the injection valve. 

• WASTE, GAS SEPARATOR carries system waste from the suppressor.

Untape the coiled waste lines from the rear panel. Place the ends of the PUMP 
WASTE and TO WASTE OUT lines into a waste container. 

Direct the WASTE, GAS SEPARATOR line from the top of the ICS-1000 to the rear 
panel. Snap the line onto one of the tubing clips on the rear panel. Connect the line 
to the gas separator waste tube (see Section 10.1).

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

10.1 Installing the Gas Separator Waste Tube

1. Locate the gas 
separator waste tube 
assembly (see 
Figure 21) in the 
ICS-1000 Ship Kit 
(P/N 057905). 

2. Connect the WASTE, 
GAS SEPARATOR 
line to the 3-mm 
(1/8-in) ID white 
Teflon tubing on the 
gas separator waste 
tube assembly.

Figure 21. Gas Separator Waste Tube Assembly

3. Place the gas separator waste tube assembly into the waste container. 
Make sure the tubing junction (where the white Teflon tubing meets 
the black polyethylene tubing) is above the top of the container and 

Connect the 
WASTE, GAS 
SEPARATOR line 
here
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that the gas separator waste tube and the waste container are open to 
the atmosphere (see Figure 22).

4. Go on to Section 11.

Figure 22. Gas Separator Waste Tube Installation

DO NOT CAP THE WASTE CONTAINER: The ICS-1000 uses an
electrolytic process that results in the production of small amounts of
oxygen or hydrogen gas. To ensure that the gas is not trapped in a
closed container and allowed to concentrate, install a 1.3-cm (0.52-in)
ID black gas separator waste tube (P/N 045460) in an uncapped waste
container. Connect the Waste, Gas Separator line to the waste tube
(see Figure 22).

NE FERMEZ PAS LE CONTENEUR DE GAZ RÉSIDUEL L : Le ICS-1000
travaille avec un proces d´électrolyse, qui produit des petites
quantités de gaz d´oxygène ou d´hydrogène. Afin de garantir que le
gaz ne soit pas enfermé dans un conteneur fermé et puisse s´y
concentrer, connectez un tube noir à gaz résiduel (diamètre intérieur =
1,3 cm ; n° de commande 045460) à un conteneur ouvert (non fermé).
Connectez le conteneur résiduel au tube résiduel/gaz séparateur
(désigné: « Waste, Gas Separator»). 

Waste
Gas Separator 
Waste Tube Assembly

Container

Waste, Gas 
Separator Line
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11 Setting Up the Eluent Reservoir

1. Rinse the eluent reservoir.

2. Prepare the eluent as instructed in the manual for the column being installed. 
The column manual is included on the Dionex Reference Library CD-ROM 
(P/N 053891), located in the Ship Kit.

3. Fill the reservoir with the prepared eluent.

4. Place the reservoir on top of the ICS-1000.

5. Install the cap and hand tighten.

NOTE The ICS-1000 does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Dionex recommends pressurizing the
reservoir with helium or nitrogen. See Section 20 for
instructions.

6. Go on to Section 12.

VERSCHLIESSEN SIE DEN ABFALLBEHÄLTER NICHT: Der ICS-1000
verwendet einen Elektrolyseprozess, wodurch kleine Mengen an
Sauerstoff und Wasserstoff entstehen. Führen Sie einen schwarzen
Gasabscheiderschlauch (ID = 1,3 cm; Bestell-Nr. 045460) in einen
offenen (unverschlossenen) Abfallbehälter, damit sich das Gas nicht
in einem geschlossenen Behälter sammelt und aufkonzentriert.
Verbinden Sie die mit Waste, Gas Separator bezeichnete Leitung mit
dem Abfallschlauch.
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12  Setting Up a Chromeleon Application

Chromeleon provides application templates, which you can use to quickly get 
started running. To use the application templates, you need to know the type of 
column and suppressor you will be using. This section shows how to create a list 
of samples to be processed (a sequence) and how to use an application template.

1. Identify the type of column and suppressor installed in the ICS-1000.

2. Start Chromeleon (select Start>Programs>Chromeleon>Chromeleon). 
The Chromeleon main window and Browser appear (see Figure 23).

Figure 23. Chromeleon Main Window and Browser
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3. In the Browser, select File>New and select Sequence (using Wizard) (see 
Figure 24).

Figure 24. Creating a New Sequence

The Sequence Wizard Welcome page appears (see Figure 25).

Figure 25. Sequence Wizard Welcome Page
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NOTE For details about a Sequence Wizard step, click the Help
button on the Sequence Wizard page.

4. Click Next>.

The Sequence Wizard Timebase page appears (see Figure 26). 

Figure 26. Example: Sequence Wizard Step 1 

5. Select the ICS-1000 timebase and click Next>.
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The Unknown Samples page appears (see Figure 27). 

Figure 27. Example: Sequence Wizard Step 2 

6. Select Use Template from the drop-down list. 

7. In the Template for Sample Name field, type Sample, click the right arrow, 
and select Sample Number #n. 

8. In the Number of Vials field, type 1.

9. Use default settings for the remaining parameters on the page.

NOTE You can edit the sequence later, to add more samples
and select the injection parameters appropriate for your
application.
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10. Click Apply. 

Figure 28 shows Sequence Wizard Step 2 after a sample is defined.

Figure 28. Example: Sequence Wizard Step 2 with Sample Defined 

11. Click Next>. 
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The Standard Samples page appears (see Figure 29). 

Figure 29. Example Sequence Wizard Step 3 

12. Click Next> to omit this step and define standard injections later. Or, define 
one or more standard injections, and then click Next>. 

The Methods & Reporting page appears
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13. Select the Use Application Template check box.

14. From the drop-down lists, select the type of suppressor to be installed and 
then select the column. 

In the example in Figure 30, the 4-mm ASRS suppressor and AS17 column 
are selected.

Figure 30. Example: Sequence Wizard Step 4 

15. To select a report template, click the Browse button, go to the Dionex 
Templates/Reports folder, and select a template (for example, default_letter).

16. Click Next>. 

The Saving the Sequence page appears.



Setting Up a Chromeleon Application

Doc. 031915-01 3/03 33

17. Enter a name for the sequence and a location (see the example in Figure 31). 

Figure 31. Example: Sequence Wizard Step 5 

18. Click Next> and then click Done on the last page of the Sequence Wizard.

The Browser appears, displaying the sequence you created (see Figure 32). 
Notice the three files in the top pane of the Browser window. 

Figure 32. Example Browser with Open Sequence
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• The .pgm file (program) contains commands and parameters for controlling 
the ICS-1000, controlling the autosampler (if used), and acquiring sample 
data. 

• The .qnt file (quantification method) contains peak identification and area 
determination parameters.

• The .pan file (Control Panel) lets you control and/or monitor the ICS-1000 
and other modules that are connected to the timebase. 

NOTE The sequence that you create here is intended as a
starting point only. You can add additional samples to
the sequence, change injection parameters, and edit the
.pgm and .qnt files. Refer to the Chromeleon online Help
for details. 

NOTE After completing the installation, see Chapter 3 in the
ICS-1000 operator’s manual (Document No. 031857) for
how to process the samples and standards in the
sequence. The manual is on the Dionex Reference
Library CD-ROM (P/N 053891).

19. Double-click the .pan file to open the Control Panel for your system (see the 
example in Figure 33).

Figure 33. ICS-1000 System Control Panel Example
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NOTE If the Connected check box is not selected, click the box
to connect the ICS-1000 to the Control Panel.

12.1 Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the ICS-1000 by clicking 
the Inject and then the Load button on the Control Panel. If 
communication is occurring, you will hear the valve actuate as it changes 
position.

Go on to Section 13.
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13 Setting the Eluent Level

After filling the reservoir, enter the volume of liquid in the reservoir on the 
Chromeleon Control Panel (see Figure 34). The ICS-1000 determines the eluent 
usage by monitoring the flow rate and the length of time the pump is on, and 
updates the Eluent Level field as the eluent is used up. A warning appears if the 
level falls below 200 mL. Warnings are repeated at 100 mL and 0 mL. 

In order for the eluent level displayed on the Control Panel to be
accurate, the level must be entered by the user when the reservoir is
filled. The ICS-1000 does not automatically detect when the reservoir
is filled, nor when it is empty.

Figure 34. Setting the Eluent Level

Enter the volume of
liquid in the reservoir

Note: The Eluent Bottle 
field and slider gauge 
are updated as the 
liquid is used up.
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14 Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and hand 
tightened, and the liquid line from the ICS-1000 to the reservoir cap is 
connected (see Section 11).

2. Verify that the waste lines are directed to a waste container.

3. The priming procedure consists of two parts:

• Priming the eluent lines with a syringe. Perform this procedure at initial 
installation, after changing eluents, or when eluent lines are empty.

• Priming the pump heads with the Prime button. Perform this procedure 
after the eluent lines are primed.

14.1 Priming the Eluent Lines with a Syringe 

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.

1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 054578) to the port in the priming 
valve on the primary pump head (see Figure 35). 

Figure 35. Priming the Eluent Lines

10 mL Syringe
(P/N 054578)

Priming Valve 
(open)

Port

Waste Valve
(close)

Primary
Pump Head

Secondary
Pump Head
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3. Open the priming valve by turning it one-quarter to one-half turn 
counterclockwise.

4. On the Chromeleon Control Panel, click Pump Settings and then 
click Eluent Flow Valve Open (see Figure 36).

Figure 36. Chromeleon Control Panel: Pump Settings 

5. Draw the syringe back to begin pulling eluent through the flow path. 
It may take several syringe draws to remove all air or previous eluent 
from the tubing.

NOTE If the vacuum degas assembly is installed, draw
out an additional 20 mL of eluent.

6. After priming the lines thoroughly, close the priming valve. Do not 
overtighten the priming valve. 

7. Close the eluent valve (click Eluent Flow Valve Closed on the 
Control Panel).
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14.2 Priming with the Prime Button

NOTE Perform this procedure after priming the eluent
lines (see Section 14.1).

1. Check that the priming valve on the primary pump head is closed (see 
Figure 37).

2. Open the waste valve on the secondary pump head by turning the 
knob one-quarter to one-half turn counterclockwise (see Figure 37). 
Opening the valve directs the eluent flow path to waste and eliminates 
backpressure.

3. Click Prime on the Chromeleon Control Panel (see Figure 36). The 
pump will begin pumping at approximately 3.0 mL/min.

4. Continue priming the ICS-1000 until no air bubbles are exiting the 
pump waste line.

5. Press Pump Off.

6. Close the waste valve. Do not overtighten. The pump is now ready 
for operation.

NOTE If the two standard priming procedures described above
are unsuccessful, prime the pump with isopropyl
alcohol. See “Chapter 5, Troubleshooting,” in the ICS-
1000 operator’s manual for instructions.

Figure 37. Priming the Pump

Priming Valve

Waste Valve

Primary
Pump Head

Secondary
Pump Head

(open)

(close)
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15 Equilibrating the System

1. After priming the pump, turn on the pump and set the flow to the operating 
rate.

2. Flush the system for about 5 minutes to equilibrate.

3. Monitor the system pressure from the Control Panel to make sure it is at the 
expected pressure for the installed column (refer to the column manual for 
details) and is stable. If the pressure is less than the expected amount, gas may 
be trapped in the system. Release the gas by removing the pump fitting on the 
injection valve. The fitting is labeled P (2). Allow the air to escape and then 
reconnect the fitting.

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and 
that the pressure is stable.

5. Monitor the baseline conductivity. In general, it should be <30 µS for a system 
set up for anion analyses, and <2 µS for a system set up for cation analyses. 
Equilibration time varies and it can take some time to reach these expected 
values.

16 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by 
monitoring the pump pressure reading on the Chromeleon Control Panel. Write 
down the short-term pressure fluctuations; they should be less than 0.13 MPa 
(20 psi).

ICS-1000 installation is complete. For routine operation, refer to ICS-1000 Ion 
Chromatography System Operator’s Manual (Document No. 031879). The 
manual is on the Dionex Reference Library CD-ROM (P/N 053891).
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17 Connecting an AS50 Autosampler (Optional)

17.1 AS50 Configuration Requirements

To use an AS50 autosampler with the ICS-1000, the AS50 must meet the 
following requirements:

• An injection valve cannot be installed in the AS50

• The AS50 must have Moduleware version 1.11 or later installed

• Control of the ICS-1000 injection valve must be enabled in the AS50

The following AS50 models are configured at the factory to meet the 
above requirements:

• AS50 without injection valve (P/N 061309)

• AS50 without injection valve; with sample preparation (P/N 061310)

• AS50 without injection valve; with sample preparation and sample 
tray cooling (P/N 061311)

• AS50 without injection valve; with sample tray cooling (P/N 061312)

Notes

• To identify the version of Moduleware currently installed in the 
AS50, go to the AS50 POWER UP screen (press Menu, 8, and 1). If a 
Moduleware update is required, contact Dionex.

• In order to use an AS50 that has an injection valve installed, the valve 
must be disconnected from the AS50 electronics. Contact Dionex for 
assistance. The AS50 electronics components cannot be serviced by 
the user. 

• If the AS50 is currently running with a Thermal Compartment (TC) 
or Chromatography Compartment (CC) and you are now going to use 
it with an ICS-1000, the injection valve is typically installed in the TC 
or CC, not in the AS50. If this is the case, verify that the correct 
Moduleware version is installed, and enable control of the ICS-1000 
injection valve (see Section 17.3).

After the AS50 is configured for use with the ICS-1000, all AS50 modes 
of injection (full-loop, partial-loop, and partial-loop limited-sample) are 
supported. In addition, all AS50 injection valve commands (whether 
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issued from the AS50 front panel or from Chromeleon) will control the 
ICS-1000 injection valve. For Chromeleon control, the AS50 must be 
added to the ICS-1000 timebase (see Section 8). For front panel control, 
the AS50 and ICS-1000 can be set up for stand-alone operation. This 
requires a TTL cable connection between the AS50 and the ICS-1000. 
See the TTL appendix in the ICS-1000 operator’s manual for stand-alone 
setup instructions.

17.2 AS50 Connections

1. Place the AS50 to the left of the ICS-1000 on the workbench. 

2. Open the ICS-1000 and AS50 doors.

3. The needle seal line that extends from the inject port in the 
autosampler is coiled inside the AS50 door, on the right side. Route 
this line through the AS50 right side slot (see Figure 38) and the ICS-
1000 left side slot to the ICS-1000 injection valve.

The needle seal line from the AS50 inject port to the ICS-1000 injection
valve is calibrated for use with the ICS-1000. To ensure injection
precision, do not shorten (by cutting) or lengthen this line, or replace
it with a different (uncalibrated) line. 

Figure 38. AS50 Drip Tray

Insert the waste line  
from the ICS-1000 
injection valve here

Route AS50 
needle seal line 
to ICS-1000 
injection valve 
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4. Connect the needle seal 
line from the AS50 to port 
S (5) on the injection valve 
(see Figure 39).

The green waste line that is 
connected to port W (6) on 
the injection valve (see 
Figure 39) is connected 
with a union to a Teflon 
waste line (see Figure 40) 
and routed through the 
tubing chase to the ICS-
1000 rear panel.

Figure 39. ICS-1000 Injection Valve

5. Disconnect the green 
waste line (labeled AS50 
TRAY) from the union and 
route the line to the drip 
tray in the autosampler 
compartment.

You can either leave the 
disconnected Teflon waste 
line and union in the 
tubing chase, or pull the 
line out from the front.

Figure 40. Injection Valve Waste Line Union

6. Push the end of the green AS50 TRAY line into the small round opening on the 
right side of the AS50 tray (see Figure 38).

NOTE For PEEK waste lines, sharply bend the waste line
tubing about 5-mm from the end to ensure it stays in
place in the opening in the drip tray. When bending the
tubing, be sure not to restrict the inner diameter.

7. If you have not already done so, add the AS50 to the Chromeleon timebase 
(see Section 8).

Make sure the injection valve waste line is not elevated above the
injection valve at any point between the valve and the AS50 drip tray. 

AS50
Needle

Seal Line

Waste
Line

AS50 TRAY 
Waste Line 
(disconnect
from union)Union

Tubing
Chase

Teflon
Waste
Line
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17.3 Enable AS50 Control of the Injection Valve

Follow the steps below if you are connecting an AS50 that was not 
configured at the factory for ICS-1000 support. Injection valve control is 
already enabled in pre-configured AS50 models (see the list in 
Section 17.1).

1. On the AS50 front panel, press Menu and 0 to go to the TIME 
FUNCTION OUT screen (see Figure 41). In the LOAD/INECT VALVE: 
TTL 1 field, select ENABLED.

2. Turn the AS50 power off and then back on.

All AS50 injection valve commands (whether issued from the AS50 
front panel or from Chromeleon) will now control the ICS-1000 
injection valve. 

Figure 41. AS50 Time Function Out Screen

Help Prompt

TIME FUNCTION OUT

TTL
1
2

LOAD/INJECT VALVE: ENABLED
LOAD/INJECT VALVE: DISABLED
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18 Connecting an AS40 Automated Sampler (Optional)

1. Place the AS40 to the left 
of the ICS-1000 on the 
workbench. 

2. Open the front door of the 
ICS-1000 and thread the 
outlet line from the AS40 
through the left side slot 
at the front of the ICS-
1000.

3. Connect the outlet line 
from the AS40 to port 
S (5) of the injection valve 
(see Figure 42).

Figure 42. ICS-1000 Injection Valve

4. Locate the relay control cable (P/N 047946) supplied with the AS40.

5. Remove the 2-position connector plug from the pair of wires labeled LOAD on 
the relay control cable.

6. Locate the 12-position connector 
plug (P/N 923686) in the ICS-
1000 Ship Kit (P/N 057905) (see 
Figure 43).

7. Attach the red wire from the 
relay control cable to position 1 
on the plug, and attach the green 
wire to position 2. This will be 
used to connect the AS40 LOAD 
relay to RELAY OUT 1 on the 
ICS-1000.

To attach a wire to the plug, strip the end of the wire, insert it into the plug, 
and use a screwdriver to tighten the locking screw.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the
connector.

AS40
Sample

Outlet Line

Figure 43. 12-Position Connector Plug

Position 1

Position 12

Locking 
Screws
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NOTE If RELAY OUT 1 is not available, you can connect to
RELAY OUT 2 or to one of the TTL outputs. For RELAY
OUT 2, connect the red wire to position 3 and the green
wire to position 4. For TTL OUT 1, connect the red wire
to position 5 and the green wire to position 11. For TTL
OUT 2, connect the red wire to position 6 and the green
wire to position 12. 

8. Connect the relay control cable's 10-position connector plug to the RELAY 
CONTROL connector on the AS40 rear panel (see Figure 44).

9. Plug the 12-position connector plug into the TTL and relay connector on the 
ICS-1000 rear panel (see Figure 44). Make sure the red wire connects to 
position 1 and the green wire connects to position 2.

The AS40 Load relay is now dedicated to the ICS-1000 RELAY OUT 1. Use this 
relay for running with Chromeleon. When you set up the ICS-1000 application 
(see Section 12), commands for controlling the AS40 Load relay and switching 
the ICS-1000 injection valve are included by default in the program file (see 
Figure 45). 

Figure 44. Example AS40 Autosampler Connection
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Figure 45. Example Program for AS40 Control

19 Analog Output Connection (Optional)

The analog output connector on the ICS-1000 rear panel outputs an analog voltage 
signal proportional to the conductivity measured by the cell. The output is filtered 
using the selected data rise time. The analog output can be connected to an 
analog-to-digital converter such as an integrator or other recording device. Refer 
to the documentation for the device for connection instructions. 

Analog output is 0 to 1V, scaled to the selected range.

For an example setup for ICS-1000 stand-alone operation with an AS50 
autosampler, see the TTL appendix in the ICS-1000 operator’s manual.

20 Pressurizing the Eluent Reservoir (Optional)

The ICS-1000 does not require pressurized reservoirs. However, if eluent is 
manually degassed or is sensitive to contamination, Dionex recommends 
pressurizing the reservoir with helium or nitrogen. The air regulator accessory 
bracket and other items needed for pressurizing the eluent reservoir must be 
ordered separately (P/N 060054).

Relay 1 turned on to start 
the AS40 Load cycle and 

Relay 1 turned off after 
  load the sample loop 
138 seconds

Injection valve
 switched to Inject 

Injection valve
 switched back
to Load
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20.1 Connecting the Gas Source (Optional)

1. Locate the barbed fitting (P/N 030071), pipe thread reducer 
(P/N 030087), 3-mm (1/8-in) ID tubing (P/N 040793), and ICS-1000 
air regulator accessory (P/N 060054). These parts must be ordered 
separately.

2. Use the barbed fitting and pipe thread reducer to connect the 3-mm 
(1/8-in) ID tubing to a clean gas source, regulated to between 0.55 
and 0.83 MPa (80 and 120 psi).

3. Push the other end of the tubing onto the inlet of the air regulator (see 
Figure 46).

4. Remove the eluent reservoir cap.

5. Connect the gas line from the eluent reservoir cap to the gas line on 
the air regulator outlet.

6. Slip the air regulator accessory bracket over the neck of the eluent 
reservoir (see Figure 46). 

Figure 46. ICS-1000 Pressurized Eluent Reservoir Connections (Optional)

Gas Inlet Line 
3-mm (1/8-in) ID

Connect to 
gas source

Eluent Gas Line

Air Regulator 
Accessory 
Bracket
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20.2 Pressurizing the Eluent Reservoir (Optional)

NOTE Do not pressurize the ICS-1000 until after the
reservoir is plumbed.

1. Pull out the air regulator knob and turn it fully counterclockwise to 
ensure there is no pressure to the reservoir when the gas source is 
turned on. 

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the 
eluent reservoir. 

4. Adjust the pressure to between 30 and 40 kPa (5 and 6 psi). Push the 
regulator knob back in. 

Do not pressurize the eluent reservoir above 70 kPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über 0,07
MPa aus. 
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21 Pump Continuous Seal Wash Connections (Optional)

The pump includes a seal wash assembly that can be set up to continuously rinse 
the back of the piston seals to remove salt crystals and prolong the life of the seals. 
Follow the steps below to set up this feature.

1. Fill a flush bottle with either deionized water or a combination of deionized 
water and 10% or 20% isopropyl alcohol. (Isopropyl alcohol will inhibit 
bacterial growth in the water.)

2. Place the flush bottle on top of the ICS-1000. During operation, gravity 
maintains flow through the pump heads.

3. The flush solution is carried to the piston seal wash assembly and out to waste 
via 1.5-mm (0.06-in) ID tubing (P/N 055847). Locate this tubing in the ICS-
1000 Ship Kit and cut the tubing into three unequal pieces in the following 
lengths:

• 117 cm (46 in)

• 152 cm (60 in)

• 15 cm (6 in)

4. Install the tubing as follows (see Figure 47 and Figure 48):

a. Push the 117-cm (46-in) piece of clear tubing onto the drain tube on the 
bottom of the secondary pump head. Place the free end of this tubing in 
the flush bottle. Make sure the end of the tubing is near the bottom of the 
bottle.

Figure 47. Primary and Secondary Pump Heads with Drain Tubes

Secondary
Pump Head

Primary Pump 
Head

Drain Tube

Drain Tube

Note: The drain 
tubes on the 
bottom of each 
pump head are not 
visible in the 
photo.
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b. Push the 152-cm (60-in) piece of clear tubing onto the drain tube on the 
top of the primary pump head. This is the waste line. Route this waste line 
through the lower tubing chase and out the back of the ICS-1000.

c. Push the 15-cm (6-in) piece of clear tubing over the drain tube on the top 
the secondary pump head. Push the other end of the tubing over the drain 
tube on the bottom of the primary pump head.

d. Place a 10 mL syringe (P/N 054578) at the end of the waste line, press the 
syringe against the line to form a seal, and draw out all of the air.

e. Push approximately 5 cm (2 in) of black 0.25-mm (0.01-in) ID tubing 
(P/N 057057) into the end of the waste line. 

NOTE The black tubing creates a flow restriction. Assuming a
height difference of about 76 cm (30 in) between the
flush bottle and the waste container, this setup provides
a flow of one drop of flush solution every 5 to 30 seconds. 

f. Place the end of the waste line in a waste container.

g. This completes the piston seal wash installation. Periodically refill the 
flush bottle and empty the waste container as required.

Figure 48. Piston Seal Wash Flow Schematic
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22 Manually Connecting to a Control Panel

This section describes how to manually connect the ICS-1000 to a Control Panel 
if you do not use the application templates described in Section 12.

1. In the Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-1000 
folder. Several System Control Panels, corresponding to various system 
configurations, are provided.

2. Open the panel for your system configuration by double-clicking its name in 
the list. For example, if your system includes an ICS-1000 and an AS50 
autosampler, double-click either ICS-1000_System_AS50.pan or ICS-
1000_Traditional_System_AS50.pan.

NOTE The two types of panels (system and traditional
system) are similar in function, but have different
“looks.” You can select either style, depending on
your personal preference.

When the Control Panel opens, the controls on the panel are not enabled (see 
Figure 49). 

Figure 49. ICS-1000 Traditional System Control Panel (Unconnected) 



Manually Connecting to a Control Panel

Doc. 031915-01 3/03 53

3. To connect the Control Panel to the ICS-1000, open the Control menu and 
click the name of the ICS-1000 timebase at the bottom of the menu.

The Control Panel is now connected to the ICS-1000 and the controls are 
enabled (see Figure 50).

Figure 50. ICS-1000 Traditional System Control Panel (Connected to the ICS-1000)
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23 Installation Troubleshooting

Problem: When the ICS-1000 power is turned on for the first time, a Windows 
message box appears asking for a USB configuration file (cmwdmusb.inf). 

Possible Cause: The USB cable was connected and the power turned on before 
Chromeleon was installed.

Solutions: 

Use one of the methods below to resolve the problem:

• Click the Cancel button on the Windows message box. Turn off the ICS-1000 
power and unplug the USB cable. Then, install Chromeleon, reconnect the 
USB cable and turn on the ICS-1000 power. Windows will now automatically 
recognize the new USB device. 

• Leave the message box open and insert the Chromeleon CD into the CD-
ROM drive. Click the Browse button on the message dialog box. The 
cmwdmusb.inf file is located in the Drivers folder on the CD.
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